MATH 143

Stata Lab 2
I.
Using the Stata Editor window to input data


We’ve seen how to use Stata to analyze data files that already exist. What if we want to enter our own new data for analysis? Let’s use data from Exercise 1.45 on page 60 of Moore & McCabe; this data will appear in homework exercises throughout the semester.


A. 
Opening an empty Stata Editor window



1. 
Start Stata by clicking on its icon (the “tic-tac-toe board”) in the “dock” at the bottom of the screen.



2. 
We want to open a window called the “Stata Editor.” Recall that this can be done in any of 3 ways: type edit in the 


“Command” window; select “Data Editor” from the Window menu at the top of the screen; or click on the “Data 


Editor” icon in the “toolbar” on the left side of the screen just below the menu bar (the correct icon looks like a 



spreadsheet with 3 columns and several rows; the fourth icon from the right on the toolbar). Whichever method you use 


will bring up the aforementioned “Stata Editor” window containing a collection of empty rows and columns.



3. 
Now you’re ready to begin entering your own data.


B.
Entering data from Exercise 1.45 on page 60 of Moore & McCabe



1.
First we’ll enter the data, typing the weight gains given on page 60 into the first column of the Stata Editor. Start by 


entering all of the data for the “control” group (Normal corn) into the first 20 rows (or “cases”); then in rows 21-40 enter 


the data for the “experimental” group (New corn). To start, use your mouse to highlight the cell in row 1 of column 1, 


type in 380 and hit “return”. Continue in this way until you’ve entered all 40 observations.



2.
Now we must name the variable (enter a column heading). At the top of the first column, you’ll see that Stata has 


automatically named the variable var1 . Double-click on this column heading, and a Variable Information window will 


open. In the Name box, type whatever you want the name of the variable to be; let’s say wt. Then move your cursor to 


the Label box and enter a more detailed description of what characteristic this variable represents; let’s say 




Weight Gain (in grams) in 21 Days. Then click OK. In the Stata Editor window, you should now see wt at 

the top of the first column.



3.
Now we’ll close the Editor window by clicking Preserve at the upper left of the window, and then clicking the red ball 


just above it. Notice that wt now shows up as the only variable in the “Variables” window.


C. Saving a data file



At this point it would be wise to save our data (so that all our data-entry time isn’t wasted if we accidentally mess up our data 
somehow with procedures we attempt later). You can save the file in one of 2 ways (menu-based or command-based).



1.
Select Save As... from the File menu at the top of the screen. A “Save file as” window should come up asking you to 


enter a name under which your file can be saved. Type chicks.1.45.dta (the usual suffix, or extension, for files 


saved in Stata format is .dta) in the Save As box; leave the Format box as Stata data file; and in the Where box, 


select the location in which you’d like the file to be saved (I’d suggest either the Desktop or the Stata Folder). Then click 

Save button at bottom right of this window.



2.
Alternatively, in the “Command” window of Stata, you could simply type save chicks.1.45.dta. This will 


automatically save the file in the same folder as Stata, which makes it easy to use the file when you want to do so later.



Whichever of these 2 methods you use to save the file, you should see a message in the “Stata Results” window confirming 

that the file has been saved.


D.
Creating new variables from old ones



We’ll want to eventually compare the weight gains of chicks in the control group to those in the experimental group. We 

could have typed in a “group identifier” as a second variable for each chick when we originally entered the data, but Stata 

allows us to do it more easily, using the generate and replace commands. Let’s see how to create a new variable called 
group, for which 1 will represent the control group and 2 will represent the experimental group.



1.
Pull down the Data menu, select the option Create or change variables, and from its submenu select Create 


new variable. This will result in a window with 2 “tabs” appearing. Click on the Main tab, and enter group in the 


Generate variable box; then enter 1 in the Contents box. Now click the if/in tab; click the “check box” in front of Obs. 


in range, and set the range from 1 to 20. Now click OK. What we’ve done is to create a new variable called group 


which has a value of 1 for its first 20 observations (and “missing values” in rows 21-40 at this point). Open the Stata 


Editor to verify this (also note that group has appeared in the “Variables” window), and then close the Editor window.



2.
Now pull down the Data menu, select the option Create or change variables, and from its submenu select 


Change contents of variable. This will result in a window with 2 “tabs” appearing. Click on the Main tab, and enter 

group in the Variable box; then enter 2 in the Contents box. Now click the if/in tab; click the “check box” in front of 


Obs. in range, and set the range from 21 to 40. Now click OK. What we’ve done here is to leave the value of group at 

1 in the first 20 rows but replace the “missing values” in the last 20 rows with 2. Open the Stata Editor to verify this, 


then close the Editor window.



3.
Stata allows us to attach “labels” to the values of variables to help us remember what they stand for (Do you remember 


whether group = 1 stands for control or experimental? Will you remember next week?). This can be done from the 


menus, but it seems much simpler to me to use a pair of commands typed into the “Command” window. First we have 


to “define a label” (let’s call it grplabel) that contains the information we want. This is done by typing 




label define grplabel 1 “Control” 2 “Experimental”



Then we’ll “apply” this label to the variable for which it’s intended by entering




label values group grplabel



Open the Stata Editor and see what the data looks like now; pretty impressive, eh? Close the Stata Editor and type 




save chicks.1.45.dta, replace 




to save an up-to-date version of your file.



4.
If you examine the “Stata Results” window, you’ll notice that everything we’ve done with respect to the new variable 


group could have been accomplished by entering into the “Command” window, in succession, these commands:




generate group=1 in 1/20




replace group=2 in 21/40




label define grplabel 1 “Control” 2 “Experimental”




label values group grplabel

E.
Analyzing the data you’ve just entered



1.
Stata can be used to analyze the data file chicks.1.45.dta to answer the questions on page 60 of Moore & 


McCabe. See if you can use Stata to answer parts a) and b) of Exercise 1.45. (I created side-by-side boxplots, rather than 

back-to-back stemplots, for the 2 groups, and computed descriptive statistics for the 2 groups; these are shown below. 


See if you can use Stata to reproduce these results; you’ll probably find the tabstat and graph box commands 


from Lab 1 to be useful. Write the components of the 5-number summaries next to appropriate places on the boxplots 


shown here.)
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2.
Moore & McCabe ask whether mean and standard deviation are appropriate measures of center and spread for this data, and 

suggest that in Section 1.3 they discuss a better way of making this decision than looking at comparative stemplots or 


boxplots. I think what they have in mind is normal quantile plots. Use Stata to produce a normal quantile plot for each 


group of chicks. (Hint: look at the Distributional graphs submenu of the Graphics menu; when you find what 


you’re after, don’t forget to take advantage of the if/in tab.) Based on your normal quantile plots, would you say mean and 

standard deviation are legitimate measures of center and spread for this data? Explain.

II.
Scatterplots, Regression, and Correlation

We’ll use the data in the file runswins03.dta to attempt to find good predictors of the number of games a baseball team will win. Open the file by entering the following into the “Command” window:


use http://www.calvin.edu/~tals/m143/runswins03.dta, clear

(The option clear instructs Stata to clear the existing data - chicks.1.45.dta - from memory before loading the new file.)


A. 
Scatterplots as indicators of direction, type and strength of association between W and other variables.



1.
Make 4 scatterplots which have W on the vertical axis and L, R, OR, and RDIFF, respectively, on the horizontal axis.




To construct a scatterplot in Stata, go to Graphics menu, select Easy graphs, then select Scatter plot from the 


submenu; click on the Main tab of the resulting window, and enter the appropriate X variable (independent variable to be 


shown on horizontal axis) and Y variable (dependent variable to be shown on vertical axis).




(If you don’t want to use menus, you can type commands such as the following into the “Command” window:




scatter W R



where the dependent variable (on vertical axis) comes first, followed by the independent variable.)




For each scatterplot, answer the following:




• Does the association between W and the variable in question appear to be positive or negative (or no association)?




• Does there seem to be a linear relationship?




• Is the relationship a relatively strong one, or does it appear to be quite weak?



2.
If you had to put the 4 possible predictor variables in order, which seems to be the best predictor of W? Which is next 


best? Third best? Worst?


B.
Line of Best Fit



1.
A typical major league team plays 162 games in a season. If I tell you how many games a team lost, can you predict 


how many games they won? What do you think a and b will be in the regression equation W = a + b*L which predicts 


wins in terms of losses? 




Let’s use Stata to draw the line of best fit and find its equation. 




To draw the line of best fit (regression line) on the scatterplot of W and L, make the following sequence of menu 


selections: Graphics, then Easy graphs, then Regression fit. Click the Main tab of the resulting window, enter 


L for the X variable and W for the Y variable, “check” the boxes for Plot scatter and Plot fitted values, and click OK. The 


desired graph will come up in the “Stata Graph” window. 




Alternatively, you could issue two Stata commands on the same line, separated by ||, to superimpose the regression line 

graph (lfit W L) on the scatterplot (scatter W L): 




scatter W L || lfit W L




To find the regression equation (equation of the line of best fit), enter the following command:




regress W L



In the “Stata Results” window, this should produce output which includes this table:

------------------------------------------------------------------------------

           W |      Coef.   Std. Err.      t    P>|t|     [95% Conf. Interval]

-------------+----------------------------------------------------------------

           L |   -.998857   .0035772  -279.23   0.000    -1.006184   -.9915295

       _cons |   161.8408   .2934292   551.55   0.000     161.2397    162.4418

------------------------------------------------------------------------------



What we’re interested in at this point is just the part that’s shaded in the table. That gives us the coefficients of the 


regression equation: W = 161.8408 + (-.998857)L. This equation is very close to, but not exactly the same as, the 


equation you predicted above. Can you explain the slight discrepancy?


2.
Find the regression equation, and plot the line of best fit, for each of the following predictors of W: R, OR, RDIFF. 


Can you explain why the “intercept” (a in W = a + b*RDIFF) for the equation predicting wins from difference between 

runs scored and runs allowed turns out to have the value it does (from a common sense perspective)?



3.
Based on the equation predicting W from R, how many wins would you predict for a team that scores 700 runs?



4.
What proportion of the variation in W is explained by L, R, OR, and RDIFF, respectively? Based on these results, 


order these 4 predictors from best to worst. How does this ordering compare to your ordering in A.2.?


C. Correlation



1.
To compute correlations between all possible pairs of the variables W, L, R, OR, RDIFF, use the following 


“pairwise correlations” command in Stata: 




pwcorr W L R OR RDIFF 




Do the signs on the correlations between W and the other variables surprise you? Are the correlations consistent with 


your answers to A.1?



2.
Based on correlations, order the 4 predictor variables from best to worst. Any difference from your ordering in B.4?

III.
Normal distribution calculations using Stata

When I was a lad, I had to learn how to use tables in textbooks to find values of logarithms or values of sine and other trigonometric functions! Nowadays, nobody would think of finding, say, log 57 from a table; instead a cheap calculator will easily produce the desired value.


Similarly, although we’ve learned to use tables to perform calculations involving normal distributions, computer-based statistics packages such as Stata are capable of doing these “table look-ups” for us. Let’s explore how this works.


A.
Standard Normal Distributions (mean = 0,  standard deviation = 1)



1.
Here are several questions we know how to answer using our z-table:




a) What proportion of the standard normal distribution lies below 2.38?




b) What proportion of the standard normal distribution lies above 1.35?




c) What proportion of the standard normal distribution lies between –2.5 and .732?




(Note that in each question we know one or more z-values, and must find percentages or proportions under the 


normal curve relative to the given z-values.)




The following instructions demonstrate how to use Stata to answer the preceding questions. 




• Type clear to “empty” the current Stata Editor. Enter the values 2.38, 1.35, –2.5, and .732 into the first 


  column, and name that column zvals (double-click on var1 at the top of the column to change its name).




• Now we’ll use the generate command to create a new variable (let’s call it areatoleft) which contains the 


  proportion of the standard normal distribution lying to the left of the z-values of interest. We’ll use Stata’s norm(x) 


  function, which gives the area to the left of whatever value x is inserted in the parentheses (essentially exactly what the 


  table inside the front cover of our textbook does).  Type the following into the “Command” window:




  generate areatoleft=norm(zvals)



 Open the Stata Editor, and look at the new second column; are the values there consistent with the old 68-95-99.7 Rule?




• Now we can answer the original questions, using the information provided in the areatoleft column. We must use 

  the same kind of reasoning we used in doing these problems with a table. Stata does not do our thinking for us; in 


  this application Stata is nothing more than an electronic table. 




  a) Since we want the fraction of the distribution below (i.e., to the left of) 2.38, we simply use the first value in the 


     areatoleft column: .9913



  b) Since we want the proportion of the distribution lying above 1.35, we must take 1 – (proportion lying below 1.35); 


     in other words our answer will be 1 – second value in areatoleft: 1 – .9115 = .0885



  c) To find the proportion of the distribution between –2.5 and .732, we subtract the area to the left of –2.5 (the third 


     value in areatoleft) from the area below .732 (the last value in areatoleft): .7679 – .0062 = .7617


2.
Here are some more questions we could handle using our table:




a) What is the z-value which is greater than 35% of all possible z-values?




b) Find the z-value which has .1369 of the distribution to its right.




(Note that in each question we know percentages or proportions under the normal curve relative to some unknown z-


value which we must find.)




The Stata function invnorm(x) will produce a z-value which has a specified area x under the normal curve to its left 


(like reading the body of our table to find a z-value in the margin). See if you can use Stata to answer the 2 questions 


above. You’ll probably enter .35 and .8631 (=1-.1369) into an empty column; name the column, say, pcts; and then 

create a new variable with the command generate zscore=invnorm(pcts). Do your results match what you get 

from the table-based approach we learned in class?


B.
Other Normal Distributions



1.
Peter Piper’s Pickled Peppers Packing Plant puts pickled peppers into plastic packages. Paper pasted to these packages 


proclaims that each package purportedly is packed with 4 pounds of peppers. Actually, each package doesn’t contain 


exactly 4 pounds; instead the contents (by weight) have a normal distribution with mean 64 oz. (4 pounds) and standard 


deviation 1.5 oz. What proportion of packages contain at least 60 oz.? What proportion of packages are within 1 ounce of 

the label weight (i.e., are between 63 and 65 oz.)? 95% of the packages weigh at least how much?




To answer questions like these, we need to convert the given data to corresponding z-zcores, and then use norm(x) (if z-


value is known) or invnorm(x) (if proportion is known).




Open the Stata Editor and enter 60, 63, and 65 in an empty column; name the column weight. Create a column of 


corresponding z-scores using the command generate z=(weight-64)/1.5 (Why??). Then create a third column 


of areas to the left of these z-score values: generate lefttail=norm(z). Then use your head to use these values 


to answer the questions. The columns you should get are reproduced below.


     +-------------------------------+

     | weight           z   lefttail |

     |-------------------------------|

  1. |     60   -2.666667   .0038304 |

  2. |     63   -.6666667   .2524925 |

  3. |     65    .6666667   .7475075 |

     +-------------------------------+



What proportion of the packages contain at least 60 oz?  1 - .0038 = .9962



What proportion of packages are within 1 ounce of the label weight (i.e., are between 63 and 65 oz.)?  




.7475 - .2525 = .4950




To answer the last of our pepper packaging questions, type generate junk=invnorm(.05). The result appears as 

a new column in the Data Editor; -1.645 is the z-value which has .05 of the distribution below it or .95 above it; to find 


the corresponding pepper package weight take 64 - 1.645(1.5) = 61.5325.

Summary for variables: wt


     by categories of: group 





	group |      mean        sd				


-------------+--------------------


     Control |    366.3   50.8052


Experimental |    402.95  42.72861


-------------+--------------------


       Total |   384.625  49.91361


----------------------------------








